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What is Gopher?

gopher  n.  1. Any of various short tailed, burrowing mammals of the 
family Geomyidae, of North America.  2. (Amer. colloq.) Native or 
inhabitant of Minnesota: the Gopher State.  3. (Amer. colloq.) One who 
runs errands, does odd-jobs, fetches or delivers documents for office 
staff.  4. (computer tech.) software following a simple protocol for 
burrowing through a TCP/IP internet.

In gopher there are different types of documents (click on the icons to see more about them):

There are files .

There are folders 

.

There are Indexed Search pointers .

There are CSO Phone Book pointer .

There are Telnet pointers .

There are other operating system based files also:

A BINHEX file .

A UUENCODED file .

A DOSBINARY file     and straight BINARY 

.

Included in the gopher protocol is support for graphic images 

,    sounds 

, and movies 

.    These file types are also considered to be binary files.    These files sometimes are in formats that 
multiple computers can read (such as GIF for images and AU for sounds, or QuickTime for movies).



The term gopherspace refers to the many different places you can jump around between using gopher.



 A file is a document that contains text.    This text can be in the form of an ASCII readable documents or 
other text encoded types.



 A folder is an item that contains more files and / or folders.    A folder can also be a pointer to different 

gopher server at another site.



 This is actually a query engine that will return documents pertaining to the search string and the 
particular search.

See Also:
Indexed Search



 A CSO Phone Book is actually a server developed at the Computer and Communications Services Office 
at the University of Illinois at Urbana and can be accessed by a client called a PH client.    BCGopher has 
built into it the ability to query these phone books.    In most cases these phone books contain information 
about Faculty, Staff, Students, or Employees at a particular site.

See Also
CSO Phone Book Searches



 These pointers contain information for a telnet connection.    BCGopher will launch the telnet application 
you specify in the configuration and automatically connect to the site pointed to.



 This is a text file encoded in the BINHEX format.    These files are typically for Macintoshes.



 This is a text file encoded in the UUENCODE format.    This file can be decoded on many types of 
machines.    This is typically a UNIX file, but can also be a DOS file.



 These are files that cannot be displayed on your screen and must be captured directly to your computer. 
In most cases these may be program files and will be operating system dependent.



 A graphic picture in binary form.    Usually in a graphics format readable by many different computers 
(such as GIF or JPG, or some other image form).    With BCGopher you need an external program to view 
this type of file.

 This icon specifically represents a GIF file, while the other icon represents any kind of image.    This 
format was added for compatibility's sake.



 A sound file is in binary form.    Usually in a sound format readable by many different computers (such as 
AU).    With BCGopher you need an external program to view this type of file.



 A movie file is in binary form.    Usually in a movie format readable by multiple types of computers (suck 
as QuickTime).    With BCGopher you need an external program to view this type of file.



Connecting to a Gopher Server (or other services)

If you have just started with BCGopher you should be given a blank window.    This window is where the 
gopher menu items are going to reside.    To connect you can use the New Gopher menu item in the File 
Menu.    Alternatively, you can have BCGopher connect to your favorite site every time you start it up.    
The way to do this is to check the Connect on Startup check box in the Configuration Dialog Box.

Once you have been connected to a server you will see (in most cases) the top level of the server.    This 
typically consists of a file describing the server and a number of folders ordered by subject.



Selecting an Item

Once you have successfully connected to a gopher server you will be presented with the many different 
services available at that server. 

By clicking on a particular icon or title you will see a Focus Rectangle.    This item is now selected.    Any 
operations made will refer to this particular item.

It is also possible to use the arrow keys to move the focus rectangle around.    To open the particular item 
you can double click on the item, or press the RETURN key.



Navigating Around Gopherspace

Some of these services can lie on servers located in different places.    They can be anywhere from a 
different office at that site, or a different site altogether, maybe even in a different country.

Any item on the menu that is represented by a folder can be one of these services, or can contain other 
information pertaining to a specific subject.

The term navigating refers to the ability to jump between different servers by using pointers to other 
servers.    You can usually jump all around the country by starting at one site.



A rectangle surrounding an item that indicates it is the point of focus.



Viewing items

In most cases everything that is not a folder can be viewed on your local system.    To view a document 
just double click on it.    BCGopher allows you to customize the way in which you view documents.    From 
the Configuration Dialog Box you can specify which application you wish to use to read a document.    If 
you double click on an item with the left mouse button the item will be brought up in the application you 
specify (called a pager).    If the document is large the first part of the document will be displayed and the 
"Save As..." dialog will allow you to name a file where the entire document will be saved on your local 
machine.    If you double click on an item with the right mouse button the document will be saved in a file 
you name and never brought up in your pager.

Other items may be binary files and, therefore, not displayable unless it is a binary image file image, 
sound, or movie.    In these cases if you double click with the left button, the file will be downloaded as a 
temporary file and opened up immediately for viewing and the subsequent temporary file deleted upon 
exiting BCGopher.    If you double click with the right button a "Save As" dialog box will ask you to name 
the file and then proceed to download it to the local computer for permanent storage.    Clicking with the 
right button does not open the file in a viewer.



Index Searches

A collection of files that pertain to the subject referred to in the title can be indexed by every "meaningful" 
word so that an interested party could do a quick search.

If you were to take all the mail messages sent to a computer support agent and put them in a database, a 
person who had a problem could read these messages looking for a problem that was similar to his and 
the corresponding answer.    This, of course, could take quite a long time.    If those messages were cross 
referenced by the problem the person would only have to look at the references to find the mail message 
that could help him.    This is the essence of an Indexed Search. 

On gopher the Indexed Search will return documents matching the particular search information in the 
form of a gopher directory.    Thus returning a document without having had to search through the entire 
hierarchical structure of a server.



CSO Phone Books

The CSO Phone Book is a different type of server.    It was originally written to be talked to from a PH 
client.    The PH style client was written in to gopher to facilitate a way to do name look ups.    These 
phone books can contain detailed information about people at a particular location.



File Menu

From the File Menu you can connect to a gopher server, save a file or exit the application.

New Gopher
Save As
Exit



New Gopher...

You can connect to a gopher server by specifying the internet address of the server in the Server Address 
box and the port number in the Server Port box.    For gopher the port number is typically 70.    Press the 
connect button to start the process.    The dialog box comes up with the default server specified in the 
configuration dialog box.



Save As...

You can invoke this function by either selecting "Save As..." from the File Menu or by double clicking on 
the particular item with the right button of your mouse.

This menu item has two functions:

If you have selected a file you will receive a "Save As" dialog box to save the particular document.    This 
will not bring up the document in the pager.

If you have selected any other type of item it will be added to the bookmark list.



Exit

As you might guess, this menu item will quit the application.    When this is done any changes made to the 
configuration or the bookmark list will be saved.



Edit Menu

Cut

There is no instance in the program (so far) that causes text to be removed.

Copy

When you have selected an item the title can be copied into the clipboard to use elsewhere.    This does 
not copy the address.

If you wish to copy the address or selector string you can use the Description Box.    When the description 
box is visible, you can select an item and use the CTRL-C accelerator keys to do the cutting.

Paste

To paste something from the clipboard there must first be something there (refer to Copy).    The only 
place in BCGopher you can paste information is the Bookmark Dialog box.    You can, of course, paste 
into other applications.



Options Menu

The different options you can alter.    By choosing the appropriate menu you can change information about 
where to connect and how to view documents, the font type, and observe information about items.

Configuration...
Font...
Description Box
Cancel Request



KMovie Player
Configuration...

In the configuration dialog box you can set a number of default information:

Default Server

The Internet Address of your favorite gopher server.    This will appear in the New Gopher dialog box when 
you use it.    If you have checked the Connect on Startup check box BCGopher will connect to this server 
when the application starts.

Default Port

If you have specified something other then a gopher server you can put in the port number here.    For 
gopher, the port number is typically 70.

Connect on Startup

Check this button if you wish BCGopher to connect to your Default Server automatically upon launching 
the application.

Differentiate gopher links

Check this button if you wish links to other Gopher Servers to appear different then directory 
items located on the same server.

Default Directory

Where the files that you receive will automatically be put when you use Save As or double click with the 
right button.

Pager

The application that you wish to use to display files.    This can be any application that will take a 
parameter as the filename to open.    The default is the Windows Notepad application.    If you use 
notepad you shouldn't have to worry about size, for BCGopher stops receiving data after 30,000 bytes 
then writes the rest to a file you specify.

Telnet Application

The application that allows you to connect to a remote site via terminal emulation.    Any item that has the 

telnet icon  will use this application to connect to the site mentioned in the item.

Image Viewer

Any binary image will use this application to be displayed.    This viewer is invoked for both the general 

image document  and the GIF 

 image type.

Sound Player

Any binary sound file will use this application to be played.    Your computer has to support sound and the 



application must support the particular format of sound chosen.

Movie Player

Any binary movie file will use this application to be played.    Your player must support this particular 
movie format (MPEG, QuickTime, etc...).

Close Configuration

Clicking this button will save the current configuration to your BCGopher.ini file, and close the dialog box.

Cancel

Clicking this button will not save any changes made to the configuration, and close the dialog box.



Font...

The font in which BCGopher displays your menu can be changed and saved.    The font, style, and size 
are all saved in the BCGopher.ini.



Description Box...

The description box is a floating dialog box that will inform you of the details of a specified item in a 
gopher menu.    This includes the file type, host name, host port, and selector string.    You can use this 
information to create bookmarks or to add to gopher servers you may have.

If the host or selector string is too long to show in the text field you can click on the field and scroll the 
string in the edit box.    You can also select the string to copy and paste in other documents.

Since the box is floating it will also always remain on top of your application.    You can click on any item in 
the menu even if the box is obscuring part of the window.    If you can't find or the box has been moved 

too far you can use the magnet button on the status bar  to get it to return to the bottom of the main 
window.

To remove the Description Box you can reselect the Description Box item in the Options Menu.



Cancel Request

You may find that some services can be very slow or respond incorrectly.    Sometimes FTP sites will allow 
a connection during the day but will respond so slow that you will be waiting for a long time.    If a request 
is not responding and it is not timing out you can choose the cancel request item to disconnect from the 
service.



What is a Bookmark?

So, you're reading a great book and just as it gets to a good part the phone rings.    You just want to finish 
this sentence.    The phone has now rung twice, and you go to put the book down but slip and grab the 
phone before the answering machine picks it up.    You finally get the phone and it turns out to be a wrong 
number.    Unfortunately, you dropped your book and now aren't sure where you were.    You thumb 
through it trying to find your place, having to re-read things you've already read.    Flipping a few pages 
ahead (because you're sure you were far past there) you start to read and realize that, not only are you a 
few pages to far, but you just read who the murderer was without the build up.    If only you had had a 
bookmark to put in your page.

I know, we all know what a bookmark is.    But it can be just as frustrating maneuvering through 
gopherspace.    You find a site that has the one FAQ you've been looking for to quickly solve a problem 
that's been plaguing you for days.    You start reading the file and instead of quitting out of the pager 
application, you mistakenly quit out of gopher.    You don't know what site you were connected to.    You 
had spent all day threading yourself through any number of sites.    If you were to make a bookmark of 
that site (or that specific document), you can go back there anytime you like.

If you create a bookmark to a site this stores the host address, port, and selector string (if needed) so that 
you can return to that site any time you wish by selecting it from the menu listing.

Bookmarks (the menu)

Add (^Add)
List...
A Bookmark
...



Add (^Add)

Once you have selected an item on your gopher menu you will be able to select the Add item from the 
Bookmark menu.    This will add the currently selected item to your bookmark list.    If you wish to add the 
current site you are currently looking at you can hold down the Control (CTRL) key and select the Add 
from the menu.    When you select the Bookmark menu you will see a little hat (^, caret, up arrow) to 
indicate that you are adding the site and not a specified item. You can also add a bookmark by double 
clicking with the right mouse button on certain items, such as a folder, Index Search, CSO Phone Book, 
and Telnet Links.    Other file types are downloaded without being display in the Pager.



The Bookmark Dialog

From the Bookmark Dialog box it is possible to add, modify, delete and go to bookmarks.

A bookmark consists of a bookmark name, item type, host address, host port, and selector string.

Bookmark Name

The Bookmark name is the name in which you will remember what the service is you are connecting to. 
This name will show up in the Bookmark Menu.

Item Type

A number that informs the client what type of item the particular service is.    For more information on item 
types refer to What is Gopher?.

Host

The internet address of the server that contains the item.

Port

The internet port of the server that contains the item.    If the item is a gopher server the port is typically 
70.

Selector

A string, usually the path name of the item.    This is used to locate (or identify) the particular item on the 
server.    If the bookmark is referring to a server the string is blank.

The Bookmark Dialog Box Buttons

(click button for explaination)



Saves changes to current bookmark list and closes dialog box.



Discards any changes made to bookmark list and closes dialog box.



Saves any changes made to bookmark list closes dialog box and connects to current bookmark selected.



Allows the addition of any bookmark to the list by hand.

When choosing Add you should make sure that you have all the information you need to fill in the 
bookmark.

Bookmark Name - The name you wish to give to this bookmark.
Item Type - The type of item the bookmark is pointing to.    You can only choose from the items in the pull 
down box.
Host - The internet address of the server.
Port - The port of the server.
Selector - The selector string that describes the path of the item.    If this is pointing to a server you must 
leave the selector blank.

Press the Add button again when finished adding, or Cancel to not add it.



Changes a currently entered bookmark.    You can change any part of the bookmark information.    Refer 
to Add for more information about the fields.



Removes the currently selected bookmark from your list.



Places the selected bookmark one level higher on the listing.



Places the selected bookmark one level lower on the listing.



Selecting Bookmarks

There are two major ways to connect to a site saved by a bookmark:

1. Select it from the Bookmark Menu.
2. Select it and press the Go To button from the BookMark Dialog Box.



Returning to Previous Sites

Whenever you double click on a folder the site that contains that folder is placed into the Recent Menu.    
The menu contains all the places you have gone since the application was started.    You can return to 
any of these places by selecting it from the Recent Menu.    A check mark will be placed next to the name 
of the site you are currently located.

Previous Site

If you wish to return to the previous site you were at you can select the Previous Site item from 

the Recent Menu or click on the arrow button  in the status bar.



The Help Menu

The fact that you are reading this file means you were able to find the Help selection under the Help 
Menu.

You can also get application information from the About item.



Frequently Asked Questions.    Typically a file containing the most frequently asked questions about a 
specific subject.    Always contains the answers to those questions (though the answer could be "no").



About BCGopher 

BCGopher was written by:

    Edmund C. Greene
    Special Services Consultant
    Information Technology
    Boston College, Boston, Mass.
    ed@bcvms.bc.edu 

It was written in Microsoft's Visual C++ V1.0.

BCGopher is copyright 1993 - Trustees of Boston College

If you like this program please let me know (it might get me a raise).

Thanks to Larry Zaborski for designing the BCGopher icon.
He will be missed.






